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Abstract 

The plant cell surface continuum is composed of the cell wall, the plasma-membrane and the 

cytoskeleton. Plasmodesmata are specialized channels in the cell wall allowing intercellular 

communication and resource distribution. Proteins within these organelles play fundamental roles in 

development, perception of the external environment and resource acquisition. Therefore, an 

understanding of protein dynamics and organization within the membrane and plasmodesmata is of 

fundamental importance to understanding both, how plants develop as well as perceive the myriad of 

external stimuli they experience and initiate appropriate downstream responses. In this chapter, I will 

describe protocols for quantifying the dynamics and organization of the plasma-membrane and 

plasmodesmata proteins across scales by determining bulk protein mobility within the membrane 

using fluorescence recovery after photobleaching (FRAP), imaging and quantification of nanodomain 

size (with Airyscan confocal microscopy) and determining the dynamics of these nanodomains at the 

single particle level using total internal reflection single particle imaging.  
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1. Introduction 

The plasma-membrane (PM) forms a barrier between the external surroundings and the cell, allowing 

the formation of an environment which is energetically favourable to biochemical processes. In 

addition to this, it is also the first point of contact of the cell with extracellular signals and stimuli. 

Proteins within the PM have fundamental roles in development via the perception and transport of 

developmental cues, perception of external stimuli and resource acquisition. In plants, the PM exists 

as part of the cell surface continuum with the plant cell wall and the actin cytoskeleton [1]. Lipids and 

proteins confined within two-dimensional plane of the membrane are able to laterally diffuse via 

thermal agitation [2]. It was hypothesized that the PM was organized as a homogenous mix of 

proteins and lipids by the fluid mosaic model [3]. However, over the last few decades this view has 

been challenged and heterogeneous distribution of PM resident proteins has been described using a 

number of different imaging techniques in mammalian [4] and plant cells [5–9]. In order to best 

describe protein dynamics and organisation in the PM, a number of techniques spanning the scale of 

PM organisation from bulk lateral diffusion to imaging and tracking individual nanodomains is 

required. These techniques can also be used to study plasmodesmata protein dynamics.   

Different proteins within the PM show different lateral mobilities within the membrane [10] as shown 

by Fluorescence Recovery After Photobleaching (FRAP). FRAP is a relatively simple but invaluable 

technique for determining the bulk lateral mobility of a fluorescently tagged protein within the 

membrane. Moreover, it is possible to perform FRAP experiments on all commercial point scanning 

confocal microscope systems without specialist technical knowledge or equipment. It allows 

determination of the mobile fraction of a protein, how much of the protein is able to freely laterally 

diffuse and the speed at which the protein diffuses through the membrane. FRAP is also extremely 

useful if domains of proteins have been modified in order to determine their effect on lateral mobility. 

For example, FORMIN1 in A. thaliana shows increased lateral mobility when its cell wall binding 

domain is removed and the cytoskeleton is depolymerised, as determined by FRAP [11]. Therefore, it 

can be useful for determining how protein function affects lateral mobility.  However, while FRAP is 



a very useful tool for determining the bulk mobility of a protein in the membrane, it does not allow us 

to determine the size and dynamics of individual protein domains within the PM.  

Protein heterogeneity in larger PM microdomains has been demonstrated by the PIN -FORMED 

(PIN) [12] and BREAKING OF ASYMMETRY IN THE STOMATAL LINEAGE (BASL) [13] 

proteins, which show polar localisations within plant cells in microdomains and their localisation is 

important for normal plant development. Moreover, the CASPARIAN STRIP MEMBRANE 

DOMAIN PROTEINS (CASP) family of proteins show highly specific polar localisation at the site of 

the soon to be formed casparian strip in the root endodermis [14]. A microdomain is defined as a PM 

protein domain which is 1μm or larger and hence, these protein microdomains can be visualised using 

standard confocal microscopy [15, 16].  

In addition to microdomains, several studies over the last decade have demonstrated the existence of 

PM nanodomains in plants. These are sub-micron protein assemblies which are 20 nm-1μm in size 

[15, 16]. The best characterised nanodomain proteins are the remorin (REM) family which exist in 

non-overlapping membrane nanodomains and are resolvable using conventional confocal microscopy 

[7, 8]. Remorins interact with the PM via their unconventional lipid binding C-terminal anchor 

domain which confers nanodomain organisation [17]. During host cell infection in Medicago, 

SYMBIOTIC REMORIN 1 (SYMREM1) segregates the receptor LYSINE MOTIF KINASE 3 

(LYK3) into nanodomains, demonstrating a molecular mechanism where REM nanodomains support 

signalling of extracellular stimuli [18].  

The diffraction limit of microscopy for GFP is ~250nm as described 100 years ago in the resolution 

equation by Ernst Abbe [19]. In order to image nanodomains smaller than this diffraction limit, super-

resolution imaging techniques have been employed by a range of research groups. High spatial 

resolution imaging of nanodomain organisation within the membrane can be performed, however for 

some techniques the frame rate of these are insufficient to determine the dynamics of nanodomains. 

Therefore, other techniques can focus on very quick image acquisition and increased temporal 

resolution.  



Spatial organization of nanodomains can be determined using techniques based on confocal 

microscopy which point scan over an area to generate an image. STimulated Emission Depletion 

(STED) imaging has demonstrated that PIN proteins localise to nanodomains within their polarised 

membrane microdomain [9]. In addition, Airyscan imaging has recently been used to image the 

proteins BRASSINOSTEROID INSENSITIVE 1 (BRI1), PLASMA MEMBRANE INTRINSIC 

PROTEIN 2A (PIP2A), FLAGELLIN-SENSITIVE 2 (FLS2), and PIN3 and shows that these form 

differently sized nanodomains within the PM [5]. Airyscan sub-diffraction limited imaging has a 

lateral resolution (X, Y axis) of 120nm and allows easy live cell imaging with all confocal-compatible 

fluorescently tagged proteins without the need to use high depletion lasers or specialist fluorophores 

[20–22]. Previously, the frame rate (temporal resolution) of Airyscan was insufficient to allow 

tracking of nanodomain dynamics. However, the release of Airyscan fast and Airyscan2 allows 

significantly faster X, Y scanning and opens up the possibility for quantification of nanodomain 

dynamics in the future [23].  

In order to determine the dynamics of nanodomains or single molecules in the membrane, the most 

readily used technique is total internal reflection fluorescence microscopy (TIRF) or Variable Angle 

Epifluorescence Microscopy (VAEM) or variations on these techniques [24]. TIRF allows 

significantly faster acquisition rates than point scanning techniques and as such is widely used for 

determining protein dynamics in the membrane. TIRF microscopy has been show to function on a 

range of organelles in plants [25]. TIRF has been used to demonstrate that perturbation of the cell wall 

and actin cytoskeleton can alter the dynamics of the PM proteins FLS2 (which perceives pathogens) 

and PIN3 (which transports an important plant hormone)[5, 10]. In addition, the pathogen receptor 

FLS2 and steroid receptor BRI1 exist within distinct remorin nanodomains as demonstrated via 

VARIABLE ANGLE EPIFLUORESCENCE MICROSCOPY (VAEM) and confocal microscopy [6]. 

This might explain how different signalling receptors achieve distinct downstream signals when 

sharing common components.  

Single Particle Tracking Photoactivated localization microscopy (sptPALM) can be performed with 

TIRF and allows sub-diffraction limited imaging. sptPALM has been used to demonstrate that RHO-



RELATED GTPASES FROM PLANTS 6 (ROP6) is stabilised into nanodomains which are required 

for auxin signalling [26]. Moreover, sptPALM has more recently been used to demonstrate that during 

hyperosmotic stimuli ROP6 is recruited to nanodomains and interacts with two NADPH oxidases 

which generate Reactive Oxygen Species (ROS) [27].  

In this chapter, methods for good sample mounting will be detailed. This will ensure reduced thermal 

drift of samples being imaged and hence higher quality data being produced for all the subsequent 

imaging methods described. In addition, FRAP determination of the bulk mobility of proteins and 

sub-diffraction limited Airyscan sub-diffraction limit imaging and quantification of individual 

nanodomains will be described. Finally, a method is provided for determining the single particle 

dynamics of nanodomains using TIRF microscopy.  The techniques described will allow a detailed 

determination of protein dynamics and organisation across scales within the PM. Moreover, these 

techniques (with the exception of single particle tracking TIRF microscopy) can be used to determine 

plasmodesmata protein organisation and dynamics. 

2. Materials

2.1 A Confocal Microscope capable of FRAP and Airyscan and a TIRF equipped inverted microscope 

(see Note 1). 

2.2 Microscopy consumables 

1. Standard glass microscope slides which fit the stage being used. 

2. No. 1.5 Coverslips (see Note 2). 

3. 3M Micropore tape. 

4. Micropipettes set and plastic tips. 

2.3 Image Analysis tools 

1. FIJI implementation of Image J (v1.53g) [28]. 

2. Graphpad Prism (version 9 is used here, but earlier versions perform curve fitting just as well). 

3. Zen Black and / or Blue with Airyscan processing enabled dongle. 



4. Imperial College London Facility for Imaging by Light Microscopy FIJI Macro package 

(https://www.imperial.ac.uk/medicine/facility-for-imaging-by-light-microscopy/software/fiji/) 

5. Line profile and FWHM Macro by John Lim, IMB (http://imagej.1557.x6.nabble.com/FWHM-

on-line-selection-td5004777.html).  

6. Trackmate (built into FIJI) [29].  

7. TrajClassifier for classification of single particle tracks [30].  

2.4 Plant sample 

Arabidopsis seedlings were grown on 0.5X Murashige & Skoog medium with 4-

Morpholineethanesulfonic acid, 2-(N-Morpholino)ethanesulfonic acid (MES) and 0.8% Phytoagar in 

16:8 light:dark cycle for 5 days. 

3. Methods 

3.1. Sample Mounting. 

For all the described techniques which follow, good mounting of the sample is fundamentally 

important irrespective of the age or complexity of the equipment being used. Sample and thermal drift 

are extremely detrimental to good data collection for PM proteins, especially when performing high 

resolution time-lapse imaging. Therefore, there are a few notes which help reduce sample and thermal 

drift of the microscope system. This procedure was developed from hundreds of trial and error tests 

and is the best found (Figure 1). While there are some methods in the literature which correct for 

linear fluorescence excitation bleaching, significant X, Y or Z sample drift will make the experimental 

data useless and if this occurs, it is best end the current data acquisition and move to a new area / 

sample.  

 [Figure 1 here] 

1. Before mounting the sample, ensure that the air conditioning in the microscope room has been on 

for at least an hour (see Note 3). 

https://www.imperial.ac.uk/medicine/facility-for-imaging-by-light-microscopy/software/fiji/
http://imagej.1557.x6.nabble.com/FWHM-on-line-selection-td5004777.html
http://imagej.1557.x6.nabble.com/FWHM-on-line-selection-td5004777.html


2. Add 100μl of dH2O (or growth medium without phytoagar) to the microscope slide using a p200 

pipette. 

3. Use fine forceps to remove the Arabidopsis seedling from the growing medium and place it onto 

the microscope slide within the dH20 droplet. 

4. Add a small amount of water to the center of the coverslip. Place one side of the coverslip on the 

slide and the other against the forceps to keep it elevated (Fig. 1A). Slide out slowly the forceps to 

allow the raised side of the coverslip to gently lower onto the sample to reduce air bubbles. If air 

bubbles occur, slide the forceps back underneath the coverslip and repeat. 

5. Wrap micropore tape over the coverslip tightly around the back of the slide on both sides (Fig. 1B), 

this significantly reduces sample drift (see Note 4). However, be careful not to crush the sample.  

6. Place the sample on the stage holder of the microscope, raise the oil immersion lens and focus. If 

time permits, leave the sample on the microscope for 5-10 minutes before imaging to reduce sample 

drift further. 

3.2. Fluorescence Recovery After Photobleaching (FRAP) 

In order to determine the bulk mobility of proteins within the plasma-membrane, Fluorescence 

Recovery After Photobleaching (FRAP) is a readily available technique which can be performed on 

all commercially available point scanning confocal systems. The technique relies on bleaching all 

fluorophores in a defined region and then determining the recovery of fluorescence over a subsequent 

time-series as freely diffusing proteins move into the bleach region (Fig 2). The monitoring of the 

diffusion of proteins into the bleached region tells us about the bulk movement of proteins within the 

membrane.  

Arabidopsis 5 day old seedlings stably expressing a plasma-membrane protein GFP fusion were used 

for all example data shown here. The stable lines used here (p35S::GFP-Lti6B and pFLS2::FLS2-

GFP) have been previously described [31, 32]. However, identical experiments have been performed 



for transient expression of proteins tagged with numerous fluorescent proteins in both N. tabacum and 

N. benthamiana and over a range of plant ages.  

[Figure 2 Here] 

1. Use 488nm laser excitation and collect emission from 500-550nm with a pinhole of 1AU for GFP 

imaging (see Note 5). If imaging samples with multiple fluorophores check no fluorescence emission 

bleed-through occurs.  

2. Set the digital zoom to 5x, frame size to 512X512 pixels, and a scan time of 0.316s (3 frames per 

second) (see Note 6&7).  

3. Define a circular region of interest in the centre of the image (Fig. 2A) keeping consistent the size 

between experiments, in Fig.2 a circle of 50 pixel diameter is used (see Note 8).  

4. Set the bleaching experiment as follows, 5 pre-bleach scans to determine the pre-bleach average 

and a time course for 240 frames which can be trimmed to allow recovery 60 seconds post bleach (see 

Note 9). Bleach the ROI using the 488nm laser set to 100% intensity for 10 iterations.  

5. Use FIJI (imageJ) (see Note 10) to extract fluorescence recovery data, an ROI is selected based on 

the bleach and control areas (Fig. 2A & B) (see Note 11). The intensity is plotted over time using the 

ROI intensity time plot macro (see Note 12) and saved into Microsoft Excel.  

7. Before curve fitting, normalise the fluorescence intensity data using the equation: In = [ (It – Imin) /  

(Imax – Imin) ] X 100 in Microsoft excel (see Note 13).  

Where: In = normalised intensity, It is the intensity at any time point, Imin is the minimum 

(initial post bleach) intensity and Imax is the average prebleach maximum intensity 

(determined from 5 pre bleach intervals taken). 

8. Copy normalised data into Graphpad prism and perform non-linear regression curve fitting using 

one- or two-phase association. Select Analyse > XY Analysis > Non-linear regression (curve fit). In 

model select one-phase (or two-phase) association. Individual curves for each FRAP experiment (Fig 

2C) and a single combined curve of all experiments (Fig 2D) should be produced (see Note 14). In 



constrain set Y0 constant equal to 0. For individual curves leave all other constraints. To generate a 

combined curve (Fig 2D) select shared value for all datasets for all values (except Y0). 

9. Key curve characteristics from the initial non constrained individual FRAP curve fits can then be 

extracted. Click on the results sheet in Graphpad. These include the plateau values, t1/2 and R2 fit of 

the curves (Fig 2E) and can be used for subsequent statistical analysis (see Note 15).  

10. In order to visualise FRAP recovery from an example dataset, produce a Kymograph (Fig 2F). In 

FIJI draw a line profile over the bleached region then Analyze > Multi Kymograph > Multi 

Kymograph (see Note 16). 

3.3 Airyscan sub-diffraction limited imaging and quantification of nanodomain size 

While FRAP determination of bulk protein remodelling in a membrane is an extremely useful 

measure of protein dynamics, more recently proteins within the PM have been shown to exist in 

nanodomains. While some of the nanodomains exist in sizes above the optical diffraction limit (for 

GFP >250nm) such as the remorins, a large number exist in nanodomains smaller than the diffraction 

limit of light and therefore super-resolution microscopy techniques are required to image them [5]. A 

large number of techniques have been used, such as STED and STORM, but here I focus on Airyscan, 

a technique developed by Carl Zeiss [20]. Airyscan imaging functions by not using a standard 

confocal pin-hole and single detector but allowing fluorescence emission to pass onto a specialised 

32-channel circular arranged detector. Each detector element has a fixed pinhole of 0.2 Airy units but 

the combined detector (sum of all elements) is 1.25 AU. Collected data is then processed with a 

Wiener filter based deconvolution and pixel reassignment [20, 22]. This culminates in sub-diffraction 

limited imaging with increased signal to noise when compared to standard confocal. This technique 

has a lateral resolution limit (X,Y) of 120nm. It is compatible with live cell imaging of any confocal- 

compatible fluorescent protein line already produced and imaged. 

[Figure 3 here] 

1. For imaging GFP use the 488nm laser and a 495-550BP + 570nm LP duel filter preceding the 

Airyscan detector and use the SP620 filter preceding the band pass filter (see Note 17).  



2. Use the highest numerical aperture lens available (see Note 18). Set the optical zoom to be above 

1.8, the pinhole open above 1AU and the frame size set to optimal which will depend on the objective 

lens and optical zoom being used (see Note 19).  

3. Ensure the detector is not saturated by using the range indicator (located on the display tab) and 

setting up appropriate master gain and laser levels (see Note 20).   

4. Focus the sample on a flat membrane sheet with a 5x optical zoom (Fig. 3A for comparison of 

confocal and Airyscan imaging on the same area using the same acquisition excitation and emission) 

(see Note 21).  

5. Always monitor the detector view when performing Airyscan imaging. Perfect data will show 

highest intensity in the central detector and then decreasing intensity radiating outwards, if this is not 

observed increase the gain or laser power or level the stage (see Note 22). 

6. Airyscan images must be processed pre analysis, using Airyscan processing on the process tab (see

Note 23).  

7. Processed Airyscan files can be opened in FIJI. There are many more nanodomains that can be 

quantified using the approach described, therefore draw a grid (Analyze > Tools > Grid) and one full 

width half maximum (FWHM) line profile of a nanodomain from each square in the grid is performed 

(Fig. 3B).  

8. Produce a full width half maximum (FWHM) measurement over a single nanodomain using FIJI. A 

line (1μm in length) is drawn over the nanodomain, its profile plotted and a gaussian curve fitted to it, 

use Analyze > Plot profile (or Ctrl+K). The distance and intensity values should be copied. A 

Gaussian curve can then be fitted using Analyze > Tools > Curve fitting, selecting Gaussian and 

inputting the plot values obtained from plot profile. This can then be used to manually determine the 

FWHM (Fig. 3C) (see Note 24).  



9.Alternatively, use available image J plugins and macros to produce FWHM measurements. The one 

used here is from John Lim of the IMB (Fig. 2C). This automatically plots the line, curve fits and 

determines the FWHM in a separate popup screen (see Note 25).  

10. Process at least 64 full width half maximum measurements per Airyscan image and 30 images in 

total across 3 experimental repeats. Convert collated FWHM measurements in excel into nm (divided 

by 1000), copy into GraphPad and produce a scatter dot plot showing nanodomain size for a given 

protein (Fig. 3D). 

3.4 Total Internal Reflection Fluorescence imaging of particle dynamics. 

Total Internal Reflection Fluorescence (TIRF) is a technique which can produce significantly high 

temporal resolution of PM proteins with enhanced signal to noise ratio. To perform TIRF a laser is 

reflected off a coverslip at a critical angle, a small amount of laser energy produces an evanescent 

wave which passes about 100nm into the sample, exciting fluorescent proteins only within this wave. 

Therefore, this technique has significant axial (Z) resolution perfectly adapted for imaging PM 

proteins. Because of the high signal to noise ratio, these particles can be tracked using several 

different methods. This is coupled with extremely fast acquisition using EM CCD cameras. These 

features allow single particle tracking to be performed (Fig. 4). 

[Figure 4 here] 

1. Mount samples as described in section 3.1 and place onto the TIRF microscope.  

2. In order to achieve TIRF, adjust the angle of the laser away from epifluorescence until the critical 

angle is reached. This is at the point when the signal ratio is highest to the background (see Note 26).  

3. Focus on the PM and blinking molecules will be observed (see Note 27, Fig. 4). Ensure the laser is 

not too powerful and rapid bleaching is not occurring. The high signal to noise ratio is required for 

subsequent tracking of molecules (see Note 28).  

4. Acquire a time course, set gain values for the camera to maximum and at least 20 frames per 

second (0.05s) acquisition is required for 60 seconds (Fig. 4).  



5. In FIJI, select Plugins > Tracking > Trackmate (see Note 29) [29].  

6. Select LoG detector to identify spots, estimated blob diameter is determined by increasing slightly 

the FWHM size determined previously (in Airyscan imaging), so here 0.2μm (200nm). Thresholding 

will enhance the quality of spots identified and is set to 50. The identified spots can then be 

previewed. Thresholding of spots should be performed based on their ‘quality’ (deviation for input 

spot size).  

7. For tracking, use the hyperstack displayer with no filter on spots selected. To track spots over time, 

select a Simple LAP tracker with a linking max distance of 0.3μm and no gap closing. Once tracked, 

tracks can be filtered by duration of tracks or number of spots. These should be set to 0.5s or 10 

respectively and ensure only spots tracked over 10 timepoints are taken further.  

8. For visualizing tracks, set track display mode to show local tracks, backwards and set color by 

duration of track. To extract individual track data, click on analysis. On the final screen an overlay 

video can be made, the trackmate file should be saved (this will be a large file). For subsequent 

analysis also export tracks in an .xml file from the final page of the plugin.  

9. After tracking is performed in trackmate, use trajClassifier [30] to classify tracks into different 

diffusion models and provide overlay videos. Open the exported tracks XML file (not the trackmate 

saved file). Overview data tables and a video will be produced.  

4. Notes 

1. For the examples listed here, a confocal microscope is required. The data presented was captured 

on a Zeiss LSM880 system with Airyscan. However, all commercially available point scanning 

confocal microscope systems will be able to perform FRAP. For super-resolution, we describe 

acquisition using the Zeiss Airyscan system. However, the analysis of nanodomain size can be used 

on data collected from several sub-diffraction limited imaging techniques. A high numerical aperture 

(at least 1.4) objective of 63X or 100X is required for high-resolution imaging described. The data 



presented was collected on a Zeiss αPlan-Apochromat 100x 1.46NA DIC M27 Elyra lens, which is 

preferred for high-resolution imaging. The TIRF microscope was configured using a AxioObserver 

stand (Zeiss) equipped with 100x objective (Zeiss αPlan-Apochromat 100x 1.46NA DIC M27 Elyra 

lens) and a manual TIRF slider (Zeiss) with a 488nm laser for excitation. Fluorescence emission was 

collected using a chroma HQ525/50 filter and an EMCCD camera was used (iXon+, Andor). 

2. Any number 1.5 coverslip can be used, however larger coverslips (24*50mm) seem to reduce 

sample drift more than smaller. This is presumed to be due to increased surface tension of the surface 

area of the coverslip and water with the microscope slide.  

3. Changes in air temperature when microscope systems are first used can significantly increase 

thermal drift of the microscope. If an on / off air conditioning is used, leave on overnight before 

imaging to ensure the room is at a stable temperature. As a minimum, the microscope stand can take 

an hour to equilibrate to a different room temperature. A temperature chamber on the stage of the 

microscope is extremely beneficial to reduce thermal drift. It insulates the stage from air currents and 

if possible should be included on future microscope purchases if high-resolution time lapse imaging is 

to be performed. The temperature can be set to that of the growth chamber (22°C). 

4. 3M Micropore tape was found to be the easiest, quickest and most versatile tape to hold coverslips 

and microscope slides together tightly and reduce sample drift. However, if longer term imaging is 

required or thicker samples are to be used double sided tape can be used to stick coverslips down in 

slides. The benefit of double sided tape is that its thickness protects the sample from mechanical 

stress. Also, if long term imaging is required Valap can be coated around the edge of the slide, 

significantly reducing water evaporation and sample drift. Valap is produced by melting equal 

volumes of Vaseline, lanolin and paraffin together. Once made it can be reheated many times. To 

reheat it is best to use a hotplate. To apply melted Valap to slides the back of a small spatula can be 

dragged along the seams of the coverslip and it sets within 10 seconds.



5. A pinhole of 1AU is optimal for most imaging experiments, however with FRAP we are not 

concerned with spatial resolution but more temporal. Therefore, a larger pinhole size can be used if 

weak fluorescence occurs. 

6. Example data collected here was generated from cotyledon cells, flat membrane sheets are imaged 

by adjusting the focus until only the top membrane of cells is visible and then using a 5X optical 

zoom (Fig. 2A). If imaging A. thaliana cotyledon cells, pavement cells immediately above the 

petioles appear more stable and show less sample drift, presumably the underlying tissue is thicker 

here.  

7. For FRAP experiments, temporal resolution trumps spatial. Therefore, the framesize can be reduced 

(e.g. 256x256) to increase scan speed and bi-directional scanning can be used. The aim is not to 

generate a pretty picture but an accurate graph.  

8. Use the pixel size from the image setup (look it up in the image metadata using the vendor’s 

software if away from the microscope), to determine the area in μm of the bleached region. 

9. All bleach settings (laser iterations, ROI etc) should be determined before the experiment begins. 

Try performing a timecourse on an area without bleaching to ensure there is no sample drift / the laser 

is not bleaching the sample during normal acquisition (Figure 2B, green line). A smaller ROI, can 

reduce the bleach energy and sample drift. The laser intensity required for bleaching should also be 

determined pre-experiment. It is best to perform as few iterations possible with 100% laser intensity. 

If using a white light laser, multiple bleaching wavelengths can be used in close wavelength proximity 

to each other to provide enough energy for bleaching to occur. The time course you set up will be 

dependent on the dynamics of the protein you are imaging. If imaging a fast diffusing protein such as 

Lti6B constant imaging can be used. However, if imaging a slower diffusing protein such as AGP4, 

an interval of 1,5s or longer can be added. This will reduce the laser power being put into the sample 

and hence sample / thermal drift over long time periods. 

10. If using Zeiss Zen software, or other manufacturers software this can be readily done by copying 

the intensity ROI data directly from the acquisition software. 



11. ROIs can then be added to the ROI manager (Analyze > Tools > ROI manager) and the ROI saved 

so it can easily be used for analysis of subsequent data files. An additional ROI of the same size can 

be used as a control in a non-bleached region.  

12. The Imperial College Facility for Imaging by Light Microscopy Multi ROI Intensity timeplot 

macro (located in the Intensity suite of tools), is then used to plot the intensity in the bleached/control 

ROI over time (Fig. 2B). This also produces a data table which can be saved as a .csv file and opened 

in excel for subsequent analysis.  Irrespective of the method used to extract the ROI intensity data 

over time, the outcome should be an excel file containing the acquisition frame interval (in seconds) 

in the first column and each experimental repeat bleached ROI intensity data in each subsequent 

column.  

13. If analysed in an excel file with the original ROI intensity data in a separate tab, data 

normalisation for all datasets can be rapidly performed by dragging the equation over multiple 

datasets from the linked sheets after ensuring appropriate row values are locked using the F4 key in 

excel. To get the correct timeseries (in seconds), the time required for the first 5 pre-bleach scans must 

be subtracted from all subsequent time points. Therefore, the first postbleach scan (timepoint 6) is 0 

seconds. 

14. Once in prism, a One or Two-phase association curve fitting can be performed with the Y0 value 

constrained to 0 (as we have normalised all data to an initial % fluorescence recovery value of 0). The 

type of curve fitting performed depends on the type of data collected. A one-phase associations was 

used here (Fig. 2). The curve fits for each time course can then be drawn as separate curves on a 

graph. It can be useful to additionally include the individual datapoints as a ‘cloud’ around the curves 

to show the spread of the combined datasets (Fig. 2C, blue dots). In order to produce a single curve 

representative of all datasets, perform another non-linear regression curve fit with Y0 set to 0 and all 

other values set to shared value for all datasets in the constrain tab. This will produce the single 

standard FRAP recovery curve for all of the datasets (Fig. 2D). 



15. These can be copied from the results tab in GraphPad and pasted into a new data table and 

compared to other experimental conditions (Fig. 2E). The plateau values indicate how mobile the 

protein is in the PM, a higher plateau demonstrates more protein has diffused into the bleach ROI. 

16. A kymograph is a line profile taken through all timepoints in the timeseries and can be used to 

visualise FRAP recovery of the line over time Remember, if doing a lot of these save the line profiles 

as an ROI in ROI manager. 

17. This ensures GFP emission passes through but can also be used for line switching if dual GFP / 

RFP imaging is being performed. Always use the highest numerical aperture objective available 

(either 63 or 100x. The 620SP filter will block chlorophyll autofluorescence from entering the 

Airyscan detector and should always be used.  

18. I have had excellent results with αPlan-Apochromat 100x 1.46NA DIC M27 Elyra lens (420792-

9800-720). Ensure any DIC prisms below the objective are removed.  

19. The optimal pixel size is linked to the area which is being imaged, therefore if acquisition rate is 

important, optical zooming as much as possible will reduce the frame size required allowing faster 

acquisition. If fast temporal acquisition is required, use a letterbox frame size (reduce the Y frame by 

half e.g. 512x256.  

20. It should be noted, while the Airyscan system can still produce impressive results with low signal, 

remember the golden rule ‘photons are the currency of microscopy’ and as such the strongest (non-

saturated) signal will produce the best results. 

21. It can help accuracy to use a piezo stage when performing high-resolution imaging 

22. Ensure the Airyscan detector is set to continually calibrate in the Zen settings. If a bright sample is 

being used and the detector still does not look aligned, try calibrating the stage to ensure it is 

perpendicular to the objective.  

23. This can either be done individually or if many data files has been collected a batch process can be 

setup and run at the end of the acquisition. For LSM880 and LSM800 the standard Airyscan 



processing has a resolution limit of 140nm. To get to 120nm process in Zen Blue and tick the 2D-SR 

mode. Also note, the wiener filter processing strength can be increased above the automatic level. 

This can increase X, Y resolution but should be performed with care, too strong processing creates 

substantial image artefacts [22]. I always image with the automatic processing strength.  

24. Per grid for nanodomain quantification, it is best to draw a line profile on the most clearly defined 

nanodomain. After analysis drawing the line into the data (Ctrl+D) can help identify which 

nanodomain was quantified later. It is always best to save this modified copy separate to keep the 

original as well.   

25. Once the FWHM macro is installed, setting a shortcut key (such as F4) allows rapid determination 

of nanodomain size when processing many images.  

26. While the initial adjustment of TIRF angle at the start of a session might take some time. 

Subsequent samples should be near TIRF when placed on the microscope and hence imaging will be 

much quicker.  

27. It is worth noting, the cell wall does appear to show some autofluorescence as does any dust on 

the coverslip or Unidentified Fluorescing Objects (UFOs) in the mounting solution (dH20 or liquid 

growth media). Due to the self-thresholding nature of CCD cameras this can be troublesome when the 

PM protein is expressed at a low level. Therefore it is important to ensure you are focused on the PM. 

A good tip is if the dots are blinking and moving.  

28. Very high expression levels of fluorescently tagged proteins can perturb subsequent particle 

tracking due to crowding. This can be solved by either using a promoter which expresses at a 

moderate level (e.g. pFLS2 or pPIN3) or performing overexpression (with p35S) but using a paGFP 

fluorescent tag instead of regular GFP. A small population of paGFP is activated and fluorescing 

without 405nm laser activation. Therefore, this can be observed and tracked without saturating the 

camera or crowding subsequent analysis.  

29. I perform TIRF imaging at the Central Laser Facility at the Rutherford Appleton laboratories in 

Harwell and they have an inhouse analysis system designed for data acquired on site [33]. However, if 



TIRF data has been acquired elsewhere Trackmate which is built into FIJI is an excellent option for 

image analysis. If using Trackmate it is a good idea to calibrate it appropriately by cropping TIRF 

data and having a small area to initially track with only a few hundred frames. This can help you 

determine the appropriate spot size, threshold and track length to use without using large amounts of 

computer time processing large datasets before optimum quantification parameters have been 

determined. But for every type of different microscope technique used or different protein tracked, the 

parameters described below will need to be modified. Settings presented here are a good starting 

point. A benefit of trackmate is you can easily go backwards and forwards between steps with ease, 

modifying parameters until you get appropriate identification of spots and tracks. 
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Figure Legends

Figure 1. Sample mounting. A) One side of the coverslip is placed flat on the microscope slide and 

fixed from moving by holding one finger towards it (White Arrowhead). The other side of the 

coverslip is raised by the forceps so the coverslip and sample are not touching. By sliding out the 

forceps (in the direction shown, black arrowhead), the coverslip is gently lowered until it touches the 

sample and the forceps are removed. B) 3M Micropore tap is wrapped over the coverslip and 

microscope slide, pulled tight and wrapped around the back of the slide.   



Figure 2. Fluorescence Recovery After Photobleaching (FRAP). A) Confocal images from FRAP 

timecourse of p35S::GFP-Lti6B. The bleached region is in red, control is in green. Representative 

images post and pre-bleach, 1, 5, 10 and 30s after bleaching. Scale bar denotes 5μm. B) 

Representative raw ROI fluorescence intensity data from FRAP of p35S::GFP-Lti6B shown in A). 

Red line shows bleached region, green control. Note little change in control intensity which indicates 

that fluorophore bleaching, sample and thermal drift are all low during imaging. C) Normalised 

intensity plots of one-phase association curve fits of p35S::GFP-Lti6B. Black lines show curve fits 

from individual bleaches, blue dots show cloud of data points. D) FRAP recovery curves from all data 

sets for pFLS2::FLS2-GFP and p35S::Lti6B-GFP. E) Box plot of plateau values for pFLS2::FLS2-



GFP and p35S::GFP-Lti6B showing Lti6B has higher mobile fraction and FLS2 higher immobile 

fraction. Red lines show mean, blue error bars (standard deviation). Statistical significance determined 

by students T-test. F) Example kymograph of p35S::GFP-Lti6b showing recovery post-bleach.  



Figure 3. Airyscan imaging of PM nanodomains and size quantification. A) Comparison of 

confocal and Airyscan imaging of pFLS2::FLS2-GFP. Nanodomains clearly resolvable with Airyscan, 

vs confocal which shows high levels of noise and no resolvable objects. Note, confocal and Airyscan 

data taken at same time, with same laser power and gain settings on the same sample therefore 

demonstrating capacity of the Airyscan system. Scale bars = 5μm, magnified imaged scale bars = 

2μm. B) Example grid over Airyscan data. Green line in first purple cell is an example 1μm line over 

nanodomain used for subsequent quantification. C) Gaussian curve fitted to nanodomain line profiles 

shown in B). D) Box plot of FWHM of multiple pFLS2::FLS2-GFP nanodomains shown in B). 

Redline = mean (163.3nm), blue error bars = standard deviation (30.59nm), N = 64 for example 

dataset.  



Figure 4. Example of pFLS2::FLS2-GFP single particle movement acquisition and tracking.

pFLS2::FLS2-GFP nanodomain movement collected by TIRF imaging over 0, 20, 40 and 60s. Purple 

lines indicate particle tracks over time. Scale bar denotes 5μm. 
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